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PrecisionID EAN & UPC Barcode Font User Manual

Notice: When you use this product you agree to the End User License Agreement (EULA). The EULA is
provided as a file in the package for this product. To view the license online, please visit
www.PrecisionlD.com/licenses/

Limitations of the demo version: The demo version of this product may be used for evaluation purposes
only. In the demo version, some of the bars in the bar-code contain the demo watermark. All other
characters and symbols are exactly the same as the purchased version. If you are using the demo version
and you would like to order, please visit: http://www.precisionid.com/
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EAN & UPC Symbology Overview

The EAN & UPC Font Package is designed to print only UCC-12, UPC-A, UPC-E, EAN-8 and EAN-13
barcode types. UPC-A is also referred to as UCC-12. Any other type of UCC or EAN barcode is usually
created with the Code 128 Fonts. EAN & UPC barcodes can only encode numbers of certain lengths
according to the chart in Fig 1 below. For UPC-A and EAN-13, an optional add-on barcode can also
encode 2 or 5 more characters. To encode the add-on in the barcode, simply append this number to the
end of the primary number.

Fig 1; data lengths for EAN & UPC Barcode Types

Barcode type Length of digits to create Function to use in VBA
EAN-8 7or8 PrecisioniD_EANS8
EAN-13 12 or 13 PrecisionID_EAN13
UPC-A 11or12 PrecisionID_UPC_A
UPC-E 11 or 12* PrecisionID_UPC E

* UPC-E is a compressed version of UPC-A, therefore all 11 or 12 digits of the UPC-A are necessary to
perform the compression.



Product Overview

Print Requirements: To create a correctly sized barcode with the EANUPC fonts, they need to be
printed between 18 and 36 points (20 points is recommended). These fonts also need to be printed on a
printer with 300 dpi or greater resolution.

EAN & UPC is a more complex bar-code type because it requires a check digit calculation and other
number pairing functions. Our PrecisionID Font Formatting Components ™ are provided with this
package to simplify this process and make printing barcodes with our fonts an easy task. The PrecisionID
Font Formatting Components ™ include a Crystal Reports UFL, Microsoft VBA module for Excel and
Access and Visual Basic source code which may also be used as a guide for conversion to other
languages. This package also provides working examples for Word, Access, Excel and Crystal Reports.

Installation

Microsoft Windows

Decompress the fonts in the supplied ZIP file with a decompression utility, such as Winzip. Our fonts are
compatible with all 32 bit versions of Windows. We recommend using the supplied Setup.exe file to
install the fonts automatically in Windows. If you wish to manually install the fonts in Windows, open
Control Panel and choose Fonts; then choose Install New Font and browse to the folder that contains the
fonts with the TTF extension you extracted from the zip file.

Macintosh OS X

Our fonts are compatible with all versions of Macintosh OS Version 10.1 and greater (OSX). Decompress
the fonts in the supplied ZIP file with a decompression utility such as Stuffit Expander. Drag the files with
the TTF extension to the Library/Fonts folder of your hard drive. To activate the fonts, restart the
application; some applications may require a restart of the computer.

Other Operating Systems

We supply Windows TrueType (TTF) fonts as well as Binary (PFB) and ASCII (PFA) versions of
PostScript fonts. Consult the documentation for your operating system about instructions and which font
to install.

Using the Fonts to Create Bar Codes

When creating barcodes with our fonts, we recommend using the PrecisionID Font Formatting
Components ™ which automatically perform the required calculations and simply return the text that is
formatted to the barcode font. When this text is printed with our barcode font, a correct barcode is created.

To calculate the check digit manually, we suggest following the Visual Basic source code we provide.
This code is located in the Examples\\VVB Module folder of the package.

Tutorials for Specific Applications

The results for the following tutorials are saved in the examples folder of the product zip file. We
encourage you to refer to the examples provided in this folder.



Microsoft Office 2010 and Office 2007 Examples

The results for the following tutorials are saved in the examples folder of the product zip file or the
product installation directory. Refer to the examples provided in this folder for quick and accurate
implementation of your PrecisionID barcode.

Microsoft Excel 2010 and Excel 2007

1.

N

N o

NOTE: the PrecisionID EANUPC TQ09 font is formatted specifically for use in Microsoft Excel.
Other fonts may work but may not format properly in the cells.

In this example we will create a barcode in cell B8 using the data from cell A8 for the barcode.
Extract the PrecisionID_C128 Module.bas file from the package and place it in a folder of your
choice.

Before creating Code 128 barcodes in Excel 2010 or 2007, you must enable the Developer Menu
to import the required module so it will run. If you already see the Developers Tab, you may skip
to Step 10

[Excel 2010] Select the File Tab and then Options from list in the left column.

[Excel 2010] In the Excel Options window select Customize Ribbon

[Excel 2010] In the right half of the window, check the “Developer” check box and click OK.
[Excel 2007] Click the Office Button and select Excel Options at the bottom.
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10. Select the Developer Tab and click the Visual Basic Icon.
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11. Choose File — Import File and navigate to the PrecisionID_EANUPC_Module.bas file located in
the Program Files\PrecisionID EANUPC Font Package folder. After this module is imported, it
will be visible in the list of modules. Choose File — Close and return to Excel.
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12. In cell B8, enter the formula =PrecisionID_UPC_A(A8) which is required to format the data to the
font. You may also use =PrecisionID_UPC_E( ); =PrecisionID_EANS( ); or
=PrecisionID_EAN13( ) for the other types of EAN and UPC barcodes.

13. Notice that the formula changed the data from cell A8 and appended additional characters at the
beginning and ending of the text. Also notice that numbers from the data maybe compressed into
other characters; this is normal when creating UPC or EAN barcodes.

14. With cell B8 selected, choose the PrecisionD EANUPC TQ9 font, which is specifically formatted
for use in Microsoft Excel, and choose 18 or greater for the point size. We also recommend
centering the text in this cell so the barcode will contain white space before and after the barcode.
You must select the appropriate font for the formula you are using. For example, if you have a
formula for the EAN & UPC barcode, you must use the EANUPC Font.

15. After selecting the bar code font, the barcode will appear. Size the width of the column so that
there is some white space before and after the bars of the barcode.

16. To create an entire column of barcodes, choose Edit — Copy with cell B8 selected.

17. Highlight cells you wish to add barcodes to in column B and choose Edit - Paste. The formula will
automatically adjust for the other cells.



Microsoft Word 2010 and Word 2007 Mail-Merge

1.
2.

Open the mail merge document.
To create a barcode in a Word 2010 or 2007 mail-merge, we must insert a merge field from a data
source that has already formatted the text for the barcode font. In this example, we use Excel as

the data source. The Excel spreadsheet data source must already be setup with barcodes just like
the Excel Tutorial in this document.

In Word 2007, select the Mailings menu item, click Start Mail Merge and select the type of
document to create.
Op) 9 VAT -

Home Insert Page Layout References

A E = Lo

| Sl oY L8

Envelopes Labels | |Start Maill] Select t |
Merge = Recipients = A

Letters

E-Mail Messages
Envelopes...
Labels...
Directory

HNormal Word Document

O E DE

/=4 Step by Step Mail Merge Wizard..

Click Select Recipients and select Use Existing List. Navigate to the spreadsheet with the barcode
data. Finally select the Worksheet within the Workbook with the data, i.e. “sheet1”.
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Place the cursor at the location for the barcode and click Insert Merge Field and select the
information to be inserted; i.e. “FormattedText”.
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If you click “Preview Results”, the text formatted for the barcode from the data source appears.
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Text formatted to barcode font:

ITESTAC.BCI

Select the text in the merged data and choose the PrecisionlD EANUPC T09 font. Make the font
18 points in size.

For additional help, see Word 2007 Help or use the Mail Merge Wizard under Mailings - Start
Mail Merge.



Microsoft Access 2010 and Access 2007
To create a UPC or EAN barcode in a Microsoft Access report:

1.
2.

3.
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Run the Setup program to install the barcode fonts, VB Module, and Access Example file.
Create a new blank database. [Access 2010] Select the File tab and double click New Database or
[Access 2007] Click the Office Button, select New, name the file, and click Create.
Enter some data into a new field. This data will be encoded into a barcode.
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Save the database.
Before creating barcodes in Microsoft Access, you must import the required module. Select
Database Tools and click the Visual Basic button.
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Select File — Import File... and navigate to the PrecisionID_C128 Module.bas, which is located
in the Program Files\PrecisionID EANUPC Font Package folder. After it is properly imported, it
will appear as one of the modules in the database.
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Save the module with the database by selecting File — Save.
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Select File — Close to return to Microsoft Access 2010 / 2007.
Create a report by selecting Create — Report in the Ribbon.
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10.

11.
12.

13.

14.

15.

16.

17.

Go to Design Mode by Right Clicking the Reports Tab and selecting Design View.
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Add a Textbox to the report. This text box will be modified to contain a barcode.

Select the textbox and if the properties window is not visible, Right click on the text box and
choose properties.

Place the formula =PrecisionID_UPC_A([Field1]) for Access 2010 or
=PrecisionID_UPC_A([Tablel.Field1]) for Access 2007 in the control source property of the text
box where Tablel is the table and Fieldl is the field that contains the data to be encoded into the
UPC or EAN barcode. You may also use the formulas =PrecisionID_UPC_E();
=PrecisionID_EANS( ); or =PrecisionID_EAN13( ) for the other UPC/EAN barcode types.
Change back to Report View by right clicking the report’s tab and selecting Report View. You
should see that the formula changed the data from the database and appended additional characters
at the beginning and ending of the text. You may notice that the numbers from the data are
compressed into other characters; this is normal when creating UPC and EAN barcodes.
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Switch back to the report in Design View, select the text box and choose one of the PrecisionID
fonts such as PrecisionID EANUPC T09 and choose 18 for the point size of the font. You must
select the appropriate font for the formula you are using

Size the text box so it is large enough to contain the entire barcode. You will need to adjust both
the height and width. Be sure to leave some extra space to the right and left of the barcode in the
report. Generally, the space should be about 3 times wider than the thickest bar in the barcode.
Switch back to Report View and the Barcode will appear in the text box.
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Microsoft Office 2000 Examples

The following tutorials are saved in the examples folder of the product zip file or in the installation
directory. Refer to the examples provided in this folder for quick and accurate implementation of your
PrecisionID barcode.

Microsoft Access 2000
To create a barcode in a Microsoft Access report:

1.
2.

oo

Run the Setup program to install the fonts and Access Example file.

Before we can create barcodes in Access, we must import the required module. Choose Modules —
Import and select the Access Example.mdb file, which will be located in the Program
Files\Precision ID EANUPC Font Package folder.

&Y Modules il
5 open..
Eroups 15 Import... |

Choose the module to import from the other database; this module should be named PrecisionID _
EANUPC_Module. After it is properly imported, it will appear as one of the modules in the
database.

Open a report in design view and add a text box to your report. The text box will be modified to
contain a barcode.

Right click on the text box and choose properties.

Place the formula =PrecisionID_UPC_A([Tablel.Field1]) (or, to create another barcode type
choose the correct function from Fig 1) in the control source property of the text box where
Tablel is the table and Fieldl is the field that contains the data you want to barcode.

Run the report. You should see that the numbers from the data are converted into other characters;
this is normal and indicates the product is working properly.
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Open a report in design view, select the text box and choose one of the PrecisionID fonts such as
PrecisionID EANUPC T12 and choose 20 for the point size of the font. You must select the
appropriate font for the formula you are using. For example, if you have a formula for the EAN or
UPC barcode, you must select the EANUPC Font.

Size the text box so it is large enough to contain the entire barcode. You will need to adjust both
the height and width. Be sure to leave some extra space to the right and left of the barcode on the
report. Generally, you need about 3 times the space to the left and right of the barcode as the
thickest bar in the bar code.

10. Save and run your report. You should see the barcode appear in the text box.



Microsoft Excel 2000

1.

no

10.
11.

NOTE: the PrecisionID EANUPC TQ09 font is formatted specifically for use in Microsoft Excel.
Other fonts may work but may not format properly in the cells.

In this example we will create a barcode in cell B10 using the data from cell A10 for the barcode.
Extract the PrecisionlD_EANUPC_Module.bas file from the package and place it in the “My
Documents” folder.

Before we can create barcodes in Excel, we must import the required module and change the
security setting so it will run. In Excel, choose Tools — Macro — Security and set the security level
to Medium. Choose Tools — Macro — Visual Basic Editor.

Tools I Data Window Help
| Macro » I Security...

ey ) Visual BasicEditor  Alt+F11 |

Choose File — Import File and select the PrecisionID_EANUPC_Module.bas file from the list of
files. After this module is imported, it will be visible in the list of modules. Choose File — Close
and return to Excel.

In cell B10, enter the formula of =PrecisionID_UPC_A(AS8) (or, to create another barcode type
choose the correct function from Fig 1) which is required to format the data to the font.

You should notice that the formula changed the data from the spreadsheet and appended additional
characters at the beginning and ending of the text. You may notice that numbers from the data are
compressed into other characters, this is normal when creating EAN & UPC barcodes.

With cell B10 selected, choose the PrecisionlD EANUPC TQ9 font, which is specifically
formatted for use in Microsoft Excel, and choose 18 or greater for the point size. We also
recommend centering the text in this cell so the barcode will contain white space before and after
the barcode. You must select the appropriate font for the formula you are using. For example, if
you have a formula for the EAN & UPC barcode, you must use the EANUPC Font.

After selecting the bar code font, you should see the barcode appear. Size the width of the column
so that there is some white space before and after the bars of the barcode.

To create an entire column of barcodes, choose Edit — Copy with cell B10 selected.

Highlight cells you wish to add barcodes to and choose Edit - Paste. The formula will
automatically adjust for the other cells.
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Microsoft Word 2000 Mail-Merge

1. Open the mail merge document.

2. To create a barcode in a Word mail-merge, we must insert a merge field from a data source that
already formatted the text to the barcode font. In this example, we use Excel as the data source.
The Excel spreadsheet data source must already be setup with barcodes just like the Excel Tutorial
in this document.

3. In Word, Choose Tools — Letters and Mailings — Mail Merge and select the Excel spreadsheet for
your data source. Be sure to select the columns and range for the cells that contain the data
formatted to the barcode font. You may have to go through the Word mail-merge tutorial for
assistance if you are unsure of how to connect to a data source or perform a mail-merge.

4. When connected to the data source, we insert the merge field of <FormattedText> into the
document. When we choose the “View Merged Data” option, we see the text formatted to the
barcode font from the data source appear.
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5. Select the text in the merged data and choose the PrecisionlD EANUPC T12 font. Make the font

20 points in size.

Crystal Reports
This example was created in Crystal Reports version 8. Implementation in other versions of Crystal
Reports is very similar if not identical. The fonts and UFL are compatible with Crystal version 7 and
above.
1. Open your Crystal Report and switch to design mode. In version 8, choose Insert — Formula Field
or in version 9 and above choose Report — Formula Workshop.
2. Right Click on Formula Fields and choose New.
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Hide

3. Give your formula field a name, in this example we will name it PrecisionID_Barcodel. In
versions 9 and above, if you are asked to use the editor or the expert, choose Use Editor.

4. In the Formula Editor, choose Functions - Additional Functions and select the
PrecisionID_UPC_A() function (or, to create another barcode type choose the correct function
from Fig 1). The U25PrecisionID.dIl UFL file must be installed before you can use this formula or
you will receive an error. This UFL file is installed by running the Setup.exe file in the font
package. The U25PrecisionID.dll file is also provided in the Crystal DLL folder of the Zip file. To
manually install it, copy it to the Windows System directory or the directory where the Crystal
DLLs are located. When the U25PrecisionID.dll file is installed and active, the PrecisionID
formulas will appear in the Formula Workshop under Additional Functions.

5. Place the cursor between the parentheses in the formula and select the field you wish to encode in
the barcode from the Report Fields area in the Formula Editor. A correct formula will appear
something like PrecisionID_UPC_A ({Tablel.Field1}) where Tablel.Fieldl is the table and field




of your database.

x| B Tablel _."‘..I Iz! PrecisionlD_PNET (string)
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‘ @= Field1 = PrecisionlD_UPC_A [string)
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PrecisionlD_UPC_E (string)
PrecisionID UPC_A ({Tablel .Fieldl})

6. The tables and fields should be visible above in your database connection. Choose Save and Close.

7. From the Field Explorer, drag the PrecisionID_Barcodel Formula Field to the report.

8. Choose File — Print Preview. You should see that the formula field formatted the data from the
database and appended additional characters at the beginning and ending of the text. You may
notice that the numbers from the data are converted into other characters; this is normal when you
are using EAN & UPC Fonts.
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9. Select the formula field and choose the PrecisionD EANUPC T12 font. Set the point size to 18
points or greater (we recommend 20 points). You must select the appropriate font for the formula
you are using.

10. Size the formula field so it is large enough to contain the entire barcode. You will need to adjust
both the height and width. Be sure to leave some extra space to the right and left of the barcode on
the report. Generally, you need about 3 times the space to the left and right of the barcode as the
thickest bar in the barcode.
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11. The barcode should now be visible when you run your report.
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Specifications

Font Point Sizes and Magnification Factor

These fonts need to be printed on a printer with 300 dpi or greater resolution at a magnification factor of
80% to 200% to meet UPC and EAN requirements. Because 22 points is a magnification factor of exactly
1, the point size you choose should be between 18 to 36 points. Try using 20 points first if it is possible,

because at 20 points the symbol is best reproduced on 300 dpi printers.

Font Names and Bar Code Height

The numbers at the end of the font name is to identify the height of the font in millimeters (mm) when
printed at 20 points. Specifications developed in the 1970s call for a height of 22 mm, however, with
modern scanners the barcode can still be read with font heights as short at 9 mm.

Font Name

Approximate Font Height at 20 points

PrecisionID EANUPC T09
PrecisionID EANUPC T12
PrecisionID EANUPC T15
PrecisionID EANUPC T18
PrecisionlD EANUPC T22

09 mm (use in Excel)

12 mm

15 mm

18 mm

22 mm (Use for UPC-A and EAN-13)

© Copyright 2010 PrecisionID.com




PrecisionID Barcode Products

PrecisionID offers a variety of barcode generation software. Visit www.PrecisionlD.com for more
information on these products.

Code 128 Barcode Fonts — Generate Code 128, UCC 128, EAN-128, and USS128 Barcodes easily
using this package.

Code 39 Barcode Fonts — Generate Code 39 (Code 3 of 9), LOGMARS, and HIBC Barcodes easily
using this package.

Interleaved 2 of 5 Barcode Fonts — Generate USS Interleaved 2 of 5, EAN-14, ITF-14, German Post
Identcode and Leitcode Barcodes easily using this package.

UPC Barcode Fonts - Generate UPC-A, UPC-E, UCC-12, EAN-8, EAN-13, ISBN, Bookland, and
JAN barcodes using this package

EAN Barcode Fonts - Generate EAN, EAN-13, EAN-8, UPC-A, UPC-E, UCC-12, ISBN, Bookland,
and JAN barcodes using this package.

POSTNET Barcode Fonts — Generate USPS POSTNET, Planet, and FIM barcodes using this package.

Native ASP Barcode Generator — Generate most common barcodes on any website utilizing this
ASP barcode generator.

Barcode ActiveX Control — Generate most common barcodes in ActiveX graphics object compatible
environments using this ActiveX control.

Data Matrix Barcode ActiveX Control — Generate Data Matrix ECC200, PDF417, and Macro
PDF417 barcodes in any ActiveX graphics objects compatible environment using this ActiveX control.

PDF417 Barcode ActiveX Control — Generate PDF417, Macro PDF417, and Data Matrix ECC200
barcodes in any ActiveX graphics objects compatible environment using this ActiveX control.

OCR-A and OCR-B Fonts — Create bank checks, passports, credit card imprints, serial labels, postal
mail, and more with this OCR-A and OCR-B font package.

MICR E13B Fonts — Create bank checks and other paper based drafting documents using this MICR
E13B Font Package.
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